
Copyright 2004,2005

1

DataWindows Training

Required Tools:
PC or laptop with DataWindowsDemo* software installed

Tutorial 1:  Getting Started and Collecting Data
Tutorial 2:  Reviewing Data
Tutorial 3:  Data Analysis and System Matching
Tutorial 4:  New Process Setup
Tutorial 5:  Student T Tests

*DataWindowsDemo can be downloaded from 
www.empirical-systems.com/support.htm
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Tutorial 1: Getting Started and Collecting Data
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Tutorial 1: Getting Started and Collecting Data

Overview

• This Tutorial will show you how to load configuration files, specify a System ID for 
data traces, connect input signals and record data traces.

• DataWindowsDemo.exe is used in the Tutorial as a simulation program that will 
enable you to collect data from a fictitious process tool.

• For this Tutorial, a DataWindows configuration file has been developed to match the 
fictitious process tool that you will be monitoring.  Configuration file development will 
be covered in Tutorial 4, New Process Setup
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Tutorial 1: Getting Started and Collecting Data

Step 1)  Loading a configuration file.

• Find the DataWindowsDemo folder in the Program folder on the Window’s Start 
Menu and select the DataWindowsDemo executable.

• After the program loads, select Read Setup… from the File menu.
• This will display a list of available process configuration files.
• Select DataWin Demo from the listed processes and click on OK.
• This configuration file was developed to illustrate the functions of DataWindows.  In 

the real world, you would load a configuration file that has been specifically designed 
by an process applications specialist that is an expert on the process tool you will be 
monitoring.  When you load process configuration files, you are loading much more 
than channel setup information (as we will soon find out).
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Tutorial 1: Getting Started and Collecting Data

Step 2)  Edit System ID and Connect input signals.

• From the Configure menu, select System Name and enter “W1001” and select OK.  
This will identify all future traces with this System ID.  This name can be changed at 
any time to indicate you have moved to a different system.

• Then, select Channel Setup from the Configure menu.  This will display a panel 
which list each of the 32 input channels.

• For each channels, you can right click on the channel name to get connection 
instructions.  For example, you can right click on Manometer 1 to read how this signal 
can be connected. 

• When you are finished with channel instructions for Manometer 1, click on Cancel or 
Ok to save.

• Also, you can change channel colors by clicking on the color box to the right of 
channel names.

• After you are done with this page, click on Cancel to return to the main screen.
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Tutorial 1: Getting Started and Collecting Data

Step 3)  Collecting Data

• Check to make sure Toggle Realtime Analysis is not checked on the Tools menu.  If it 
is, use the mouse to toggle it until it becomes unchecked (this option will be covered in 
Tutorial 3).

• Click on Start to start simulated data collection.  A message box will inform you that 
data collection will start when Trigger 1 is true.  Click on Ok.

• The simulation will run a short precoat followed by 16, 2 step deposition cycles.  Note 
the data will be identified with System ID, Date and Time.  You can add a comment 
for each run by typing in the comment field.  When the run is complete the comment 
will be saved.

• After the 16 cycles, another precoat will begin followed by another 16 cycles. Until 
you click on the Stop button, this sequence will continue.
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Tutorial 1: Getting Started and Collecting Data

Step 4)  Changing the view while data collection is active.

• A Legend is displayed in the top right corner of the display.
• You can toggle visibility of the Legend by selecting or un-selecting Legend from the 

View menu or by pressing Ctrl L. 
• The Legend can be resized by holding down the left mouse button and dragging the 

left edge of the Legend.
• You can hide channel traces by selecting Display/Hide Traces from the View menu or 

pressing Ctrl T.  Then with the mouse, check only those channels you want to display. 
 Hiding a channel does not inhibit data collection for that channel.

• You can also change the axes’ scale by selecting Change X-Y Scale from the View 
menu.  When scales are changed, the screen will be cleared and new data will be added 
to the screen.  
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Tutorial 1: Getting Started and Collecting Data

Step 5)  Making sure you can save data at the rate you are collecting it.

• At high sample rates and/or with many active channels, the PC or laptop that is 
collecting data has a lot of work to do.  Each second, it must transfer data from the data 
acquisition system, process the data, and save it to disk.  This must be done before one 
second elapses or a buffer over run will occur and the data trace will have a gap in it.  
A gap in a data trace could produce a very disturbing situation: bad data results in a 
bad diagnosis of a process tool which results in the tool being needlessly taken off line. 
 DataWindows was designed to prevent this situation.

• A bar graph at the top of the screen labeled Status displays the CPU Usage required to 
transfer data, process it and to save it.  0% is on the left and 100% is on the right.  
Usually, this graph will display a value which is very near zero.  
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Tutorial 1: Getting Started and Collecting Data

Step 5)  Making sure you can save data at the rate you are collecting it (continued).

• The Status bar graph can be monitored to determined the potential to generate a buffer 
overrun and produce a gap in data.  A bar graph that is constantly displaying a value 
near zero indicates the potential is low and that no action in needed.  A bar graph that is 
displaying a value near 100% indicates the potential is high and that the user should 
take steps to reduce CPU Usage.  To reduce CPU Usage, the user can exit other 
applications, reduce the sample rate or reduce the channel count.

• When you are comfortable with the material in this tutorial, leave the simulation 
program running and continue to Tutorial 2 on the next page.
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Tutorial 2: Reviewing Data
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Tutorial 2: Reviewing Data

Step 1)  Selecting data to review.

• While collecting data, it is possible to review data by starting a special viewer program 
that was created for this purpose.  To do this, find and select DataWindowsReview in 
the DataWindowsDemo folder of Window’s Start menu.  This will launch a new 
program that is identical to DataWindows except data collection is inhibited.
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Tutorial 2: Reviewing Data

Step 2)  Selecting data to review.

• From the DataWindowsReview program, click on the Playback button.  This will 
display a list of available data to playback.

• The first entry in the Trace ID listbox is identified as DataWin Demo POR.  It is not 
part of the data set you have collected.  This entry is part of the configuration file 
which was loaded when you selected the DataWin Demo process in Tutorial 1.  Each 
process configuration file will have is own POR.  The POR gives you chance to see 
how an process expert expects the data to look.  We can now compare the data we just 
collected to the DataWin Demo POR.
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Tutorial 2: Reviewing Data

Step 2)  Selecting data to review (continued).
• Below the POR entry in the Trace ID listbox, will be displayed a chronological list of 

collected data.
• As you click on Trace IDs, the fields on the right (System ID, Process, Date, Time, 

Triggers in the run and Active Channels) will be updated with information from that 
run.  

• Trace Ids that are preceded with a '+' symbol have more than one triggered event.  
Each triggered event can be replayed individually by double clicking on the Trace ID 
to display the individual triggers, then select the trigger event of interest.

• If you change your mind and would like to select an entire run, click on the entry 
preceded with a '-' symbol (the '-' is only visible when a run is expanded).

• Each selected data set will have a check mark preceding it.  Many data traces can be 
selected as a combination of individual triggers and/or complete Trace IDs.
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Tutorial 2: Reviewing Data

Step 3)  Reviewing Data with Auto X Scale

• Data can be replayed to several destinations.  For now, select Strip Chart with Auto 
X Scale from the Playback Destination list box.  This option will display all selected 
data onto one graph in the chronological order it was collected.  The POR, if selected, 
will be displayed as the last one on the right.

• For this tutorial please limit your selections to less than 20 triggered events.  After you 
have made your data selection and destination selection, click on Ok to view the data.
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Tutorial 2: Reviewing Data

Step 4)  Zooming

• Once traces have been replayed, points of interest can be zoomed with a Ctrl left click 
of the mouse.  

• A Ctrl right click will zoom out.
• Further zoom options are available by right clicking on the graph area.
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Tutorial 2: Reviewing Data

Step 5)  View Options and Printing

• If you want to set X-Y scales to specific value, select Change X-Y Scale from the 
View menu.

• The visibility of channels can be toggled by selecting Display/Hide Traces from the 
View menu or by pressing Ctrl T.

• To generate PDF files, click on the Print to PDF button.  Adobe Reader must be 
installed to view these files.
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Tutorial 2: Reviewing Data

Step 6)  Reviewing Data with Overlay Charts

• It is often necessary to compare one data trace to another.  With the Auto X scale 
option, it is only possible to do this in a limited manner because traces can only be 
placed next to each other.  In some cases, it is more useful to compare traces with an 
Overlay Chart.

• An Overlay Chart will align data sets so that their triggers are aligned on the X Scale.  
This option is very useful for detecting timing problems.

• The Overlay Chart can be selected, after clicking on the Playback button, from the 
Playback Destination control.

• Expand one of the data sets in the Trace ID column which is preceded with a ‘+’ to 
display individual triggers.

• Select one the of the triggers and select Strip Chart Overlay Chart with Auto X 
Scale from the destination control and click on OK.
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Tutorial 2: Reviewing Data

Step 7)  Reviewing Data with Overlay Charts (continued)
• After selecting Strip Chart Overlay Chart with Auto X Scale from the destination 

control and clicking on OK, a popup dialog gives you the option to Add to current 
chart or Create a new chart.

• Select Create a new chart and observe the displayed data.
• Then click on the Playback button again.
• This time select the POR entry from the Trace ID listbox.
• Then, make sure Strip Chart Overlay Chart with Auto X Scale is selected on the 

destination control and click on OK.
• Select the Add to current chart option.
• This will add the new data to the previous chart.  The first data set will be displayed 

with solid lines.  All traces after the first will be displayed with dash traces.  
• Channel visibility can be toggled by pressing Ctrl T.
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Tutorial 2: Reviewing Data

Step 8)  Reviewing Data with Strip Charts

• Often it is useful to playback data in the same manner that it was collected.  This can 
be performed by selecting Strip Chart for the playback destination.

• This method enables the user to playback large amounts of data without worrying 
about memory limitations.

• Also, when this method is selected, the user is presented with playback controls 
(shown below) to fast forward, play, step forward, step back, and reverse.

• Click on Playback and replay a few files with this method.
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Tutorial 2: Reviewing Data

Step 8) Check on Data Collection 

• Press Alt-Tab to switch back to the DataWindowsDemo program to check on data 
collection.  Then switch back to DataWindowsReview and Playback a few more 
traces.
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Tutorial 3: Data Analysis and System Matching
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Tutorial 3: Data Analysis and System Matching

Overview

• Now that you are familiar collecting and reviewing data with DataWindows, it is time 
to learn how to analyze data with statistics, timers and step characterization tools.

• This Tutorial will first show you how to manually analyze data, then it will show you 
how to do it automatically.

• After this, you will be shown how to generate a system match Summary Report.
• For this Tutorial, we will continue to use the same configuration file as previous 

Tutorials.  This configuration file is similar to what you may be given in the field when 
you need to match a process tool to a Process of Record.

• We will learn how to analyze data, find out how to view results in SPC Charts and 
enable Realtime Analysis in this Tutorial.
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Tutorial 3: Data Analysis and System Matching

Overview (continued)

Available Statistics

• Channel Mean
• Channel Standard Deviation
• Channel Maximum
• Channel Minimum
• Typical uses: pressure, temperature, bus current or voltage
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Tutorial 3: Data Analysis and System Matching

Overview (continued)

Timers

• Independent start and 
stop events

• Noise tolerant due to 100 
mV hysteresis

• Typical uses: software 
verification, monitor 
critical valve timing, 
determine stability time 
after an event
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Tutorial 3: Data Analysis and System Matching

Overview (continued)

Step Characterization Tests

• Stability Time
• Overshoot Area
• Undershoot Area
• Maximum Overshoot
• Minimum Overshoot
• Decay Constant
• Typical uses: MFC 

monitoring, control loop 
testing
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Tutorial 3: Data Analysis and System Matching

Step 1  Manually Analyzing Data
• While you are collecting new data with the DataWindowsDemo program, press Alt 

Tab to return to DataWindowsReview. 
• Click on Playback.
• Be sure to select at least 2 data sets with 16 triggers.  This will generate the data 

necessary to complete this Tutorial (please make a note of the data sets that are 
selected for future reference).

• Select Strip Chart from the Playback Destination.
• From the Analyze Option list box, select Analyze Data. 
• Click on OK.  
• Then click on the fast forward button to speed things up.
• During the replay, tests that have been configured in the DataWin Demo setup will be 

performed and the results of the tests will be compared to specification limits.  When 
violations are detected, alarms will be generated.
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Tutorial 3: Data Analysis and System Matching

Step 2  Reviewing Analysis Results

• DataWindowsDemo generates simulated process data with random number 
generators.  To illustrate system matching failures,  the simulator will also generate out 
of family data that will almost certainly generate errors.  After completing Step 1, if 
you don’t get an MFC A Setup Overshoot Area error, go back and repeat Step 1 with 
a different Trace ID. 

• A popup panel will display error information about the violations.  After reviewing 
error info, click on OK.

• You may notice that MFC A data collected for the 10th trigger is out of family.  
However, it is difficult to assess from a strip chart graph.

• For a definitive answer, select Step Channel Charts from the SPC Charts menu.  
Then select MFC A Readback followed by Step 1 Overshoot Area.  This will 
display a panel which will allow you to select data to review in a SPC Chart.  Click on 
OK to accept the default values.
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Tutorial 3: Data Analysis and System Matching

Step 3  Viewing SPC Charts

• SPC Charts display 
processed data in a 
chronological order.

• Each point is the result of 
the calculation that was 
done on the raw data.

• You can click on each point 
to display System ID, Trace 
ID, Trigger Number, Date 
and Time.

• Spec limits are charted in 
red and 3 sigma limits are in 
green.

SPC Chart



Copyright 2004,2005

29

Tutorial 3: Data Analysis and System Matching

• From the SPC Chart, it is 
obvious that trigger 10 is out 
of family.

• To further investigate, 
double click on one of the 
out of spec points.

• Click Yes, to confirm your 
intention to view a strip 
chart for that point.

• Then select channels MFC 
A Setpoint and MFC A 
Readback from the popup 
panel.

Step 4  Displaying raw data from SPC Charts

SPC Chart
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Tutorial 3: Data Analysis and System Matching

• Select Create a new chart 
option.

• Now, double click on one of 
the in spec data points on 
the SPC Chart.

• Click on Yes to confirm.
• Select channels MFC A 

Setpoint and MFC A 
Readback and hit Ok.

• Click on Add to current 
chart (new data will be 
overlaid with dashes).

Step 4  Displaying raw data from SPC Charts (continued).

Overlay Chart
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Tutorial 3: Data Analysis and System Matching

• Select Generate System Matching Report from the Tools menu.
• Then select from the Trace ID list box the runs that you manually analyzed.
• Click on OK.
• A popup panel will tell you if any violations occurred on those runs.
• Then, text will be displayed in Notepad.
• For each critical process parameter, an entry in the text file will tell you whether the test 

passed or failed.
• You can save the file, print it or cut and paste it into another document.

Step 5  Generating System Matching Report
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Tutorial 3: Data Analysis and System Matching

• For further investigation, see if you can use the skills that you have learned to first 
display the SPC Charts for each of the errors that were generated.

• Then from the SPC charts, display the strip chart data and determine why the error was 
generated.

• For example, you can investigate the cause of Deposition 1 Timer errors, by reviewing 
the Deposition 1 Time SPC Chart.

Step 6  Further Investigation
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Tutorial 3: Data Analysis and System Matching

• Press Alt Tab to return to DataWindowsDemo.
• Click on Stop to halt data collection.
• From the Tools menu, select Toggle Realtime Analysis.
• Verify a check mark appears next to Toggle Realtime Analysis.
• Then click on Start.
• Data collection will begin and data analysis will be performed on traces as they are 

collected.
• After a few minutes, the screen will turn yellow to indicate an error has occurred and a 

popup panel will inform you of violation details.
• Alarms can be viewed and cleared from the DataWindowsReview application by 

selecting Clear Current Alarms from the Alarms menu.

Step 7  Activating Realtime Analysis
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Tutorial 4  New Process Setup
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Tutorial 4: New Process Setup

• The previous Tutorials have utilized a predefined configuration file.  It was assumed 
this file was correctly setup to not only collect data but also to process the data and to 
determine when data meets specifications.

• This Tutorial will demonstrate how to generate a configuration file if one is not 
available.

Overview
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Tutorial 4: New Process Setup

• Switch to the DataWindowsDemo application and click on Stop (if necessary).
• Select Save Process As… from the File menu and enter a descriptive name to identify 

the new process setup file.
• Click on Ok.

Step 1  Saving a new configuration file.
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Tutorial 4: New Process Setup

• Select Channel Setup from the Configure menu.
• As you connect each channel to the MX32USB data acquisition board,  toggle each 

channel Status button to On and enter a descriptive text name in the Channel Name 
field.

• Then, right click on the channel name and enter connection instructions.
• To calculate channel mean, standard deviation, maximum and minimum set the Data 

Type to Static.
• To characterize MFCs, channel Data Type should be set to Step.
• For all other channels select Valve as the Data Type (this reduces the number of 

calculations the software has to do).
• A linear transformation will be preformed on each channel, Y = A * X + B.  If you 

would like to convert voltage to engineering units, enter the appropriate values.  
Otherwise, set A = 1 and B = 0.

• Click on Ok, when finished.

Step 2  Channel Setup
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Tutorial 4: New Process Setup

• Select Daq Setup from the Configure menu.
• From the Sample Rate listbox, select a sample rate that will meet your requirements.
• Click on Ok.

Step 3  Selecting a sample rate.
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Tutorial 4: New Process Setup

• Data triggers are required to collect data when data of interest is available.
• Select Trigger Setup from the Configure menu to display the trigger setup panel.
• Up to 2 logical conditions can be activated to generate a data trigger.  
• To activate Trigger #1, select a trigger channel from Trigger #1, Trigger Channel 

listbox.  Then specify a greater than or less than condition and a trigger value.
• Trigger #2 can be deactivated by selecting Disable from Trigger #2 Trigger Channel 

listbox.  To activate Trigger #2, select a trigger channel from Trigger #2, Trigger 
Channel listbox.  Then specify a greater than or less than condition and trigger value.

Step 4  Trigger Setup
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Tutorial 4: New Process Setup

Example:  
You may want to collect data when Valve 1 signal goes above 1.0, but only during 
a deposition cycle (not during a gas box flush).  During a fictitious deposition cycle 
Manometer 1 is > 30.0 while during a gas box flush Manometer 1 is < 10.0.  
Below, it is shown how to enter this information.

Step 4  Trigger Setup (continued)
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Tutorial 4: New Process Setup

• 1 to 2 seconds of data prior to a true data collection trigger will be saved in data files.  
This ensures the user will not miss transient activity when the trigger occurs.

• The Trigger Delay parameter is used to determine when data collection ends.  To stop 
collecting data 10 sec after a trigger condition, set the Trigger Delay to 10.

• The end of the data file also depends on whether the trigger is set to a gate or an edge 
trigger.  For a gate trigger, data collection will end when the Trigger Delay expires after 
the trigger becomes false.  For a edge trigger, data collection will end when the Trigger 
Delay expires after the trigger becomes true.

• The Minimum Trigger Width can be used to ignore triggers that occur before  the 
Trigger Delay transpires.  This useful when a process sequence has several conditions 
that meet trigger conditions, but you don’t want to start another trace.

Step 4  Trigger Setup (continued)
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Tutorial 4: New Process Setup

• The Precoat Limit can be used to classify traces as precoats.  For example, set the 
Precoat Limit to to 80 to identify traces longer than 80 seconds as precoat traces.  When 
a trace is identified as a precoat, the data will be identified with a precoat suffix

• After you have finished trigger configuration, click on OK.
• Then Click on Start to test the trigger.  If the trigger operates correctly, proceed to the 

next step.  Otherwise, repeat Step 4 until the trigger functions as desired.

Step 4  Trigger Setup (continued)
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Tutorial 4: New Process Setup
Step 4  Trigger Setup (example)

Set Precoat Limit 
to 15 sec to 

classify this trace 
as a precoat.

Select Gate Trigger 
and set Minimum 
Trigger Width to 4 
sec to prevent a 
new triggered 

event from starting 
when the second 

trigger occurs.

Set Trigger Delay 
to 8 sec to collect 
data between dep 

cycles without 
gaps.

A new data file will be 
started for Dep 2 

(because the Minimum 
Trigger Width was 
exceeded between 
Dep 1 and Dep 2).  

This enables each dep 
cycle to be identified, 

processed and 
available for review.

17 sec precoat Dep 1 Dep 2



Copyright 2004,2005

44

Tutorial 4: New Process Setup

• After Trigger Setup has been completed, collect several sets of data to verify the trigger 
and to generate a data set from which a Process of Record can be selected from.

• The selected POR will serve as a model for all other traces and will enable timers to be 
setup.  Data should be reviewed to determine the Trace ID and the Trigger number 
which would be most appropriate for the POR.

• After a trace has been selected to be the POR, select Choose the Process of Record 
from… from the File menu.

• Then select the Trace ID from the Trace ID listbox and the Trigger number from the 
Trigger listbox to create a new POR.

• Once the process of record has been selected, it will become part of the process setup.  
When you export a process and send it to the field, DataWindows will make a copy of 
the POR and save it with the exported process.  In this way, users in the field will also 
be able to review and compare their data to the same POR you have identified.

Step 5  Selecting a Process of Record (POR)
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Tutorial 4: New Process Setup

• To configure timers, select 
Timer Setup from the 
Configure menu.

• If necessary, delete 
unwanted timers by 
selecting them from the 
Selected Timer listbox and 
clicking on Delete Timer.

• Then click on Add Timer 
and enter start and finish 
conditions as prompted.

Step 6  Configuring timers
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Tutorial 4: New Process Setup

• The start channel will be 
displayed in green and the 
stop channel will be 
displayed in red.

• If necessary, adjust the start 
or stop conditions until the 
desired conditions are 
specified, then click on the 
Apply button.

• Each event will be 
highlighted with a dot.

Step 6  Configuring timers (continued)
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Tutorial 4: New Process Setup

• If necessary, click on the 
Next Start Event or the 
Previous Start Event until 
the correct start event is 
specified.

• If necessary, click on the 
Next End Event or the 
Previous End Event until the 
correct end event is 
specified.

• To add another timer, click 
on Add Timer.

• When finished, click on Exit 
Timer Setup.

Step 6  Configuring timers (continued)



Copyright 2004,2005

48

Tutorial 4: New Process Setup

• Select Step Channel Setup 
from the Configure menu.

• Select each step channel in the 
Step Channel listbox.

• For each step channel, specify 
a Step Trigger Channel.  A 
Step Trigger Channel is used 
to start step testing.  For 
MFCs, setpoint makes an 
excellent Step Trigger 
Channel.

Step 7  Configuring step channels
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Tutorial 4: New Process Setup

• Also, for each step channel, 
specify the number of 
Steps/Trigger.

• The Stability Test Range will 
default to 90 to 110% of 
setpoint.  If you would like to 
alter this, click on the Stability 
Test Range button.

• Click on Ok.

Step 7  Configuring step channels (continued)
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Tutorial 4: New Process Setup

• After completing timer and step setup.  Turn Realtime Analysis on (by selecting 
Realtime Analysis from the Tools menu), then click on Start to collect data.

• After collecting at least 16 triggered events, switch to the DataWindowsReview 
application and click on the SPC Charts menu and select a SPC Chart of interest.  

• Select the new data from the Batch Selection listbox then click on Ok.
• The displayed SPC Chart will show both 3 sigma limits and specification limits (if 

specified).
• To change spec limits, click on the Control Limits button, adjust the limits and click on 

Ok.
• Click on Ok and repeat for each SPC Chart of interest.

Step 8  Setting up Spec Limits
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Tutorial 5  Student T Test
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Tutorial 5:  Student T Tests

A Student T Test is a statistical test that can be used to compare two data sets.  Specifically, 
it will tell you the probability of a difference between them.  This Tutorial will show you 
how to perform these tests and how to generate a test report.  It is assumed by this time that 
you are familiar the subjects covered in the previous Tutorials and that you can  
successfully simulate deposition cycles with the Realtime Analysis enabled.  

Overview
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Tutorial 5:  Student T Tests

Situations to use a Student T Tests:

• New software has be installed on your process tool and you want to know it the 
change affected process performance.  

• Or, you may want to know if the new MFC you have installed is statistically 
different than the old one.   

• Or, you may want to compare field data to final test data.
• Or, you may want to compare deposition cycle 1 to deposition cycle 10.
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• Load the DataWin Demo process.
• Make sure Toggle Realtime Analysis on the Tools menu has a check mark next to it.
• Change the system name to W100 (select System Name from the Configure menu).  

Then simulate 16 deposition cycles by clicking on Start.  After 16 cycles have 
completed, click on Stop.

• Now change the system name to W101 and simulate another 16 cycle run.  We will 
begin this tutorial by comparing system W100 to system W101 to see if there is a 
difference between them.

Data Preparation
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Tutorial 5:  Student T Tests

• From DataWindowsDemo or DataWindowsReview, select Compare Data Sets from 
the Tools menu.  This will display a panel that will guide you through the 5 steps of this 
Tutorial.

• Click on the first button, Select Process of Record Batches.  Do not confuse Process of 
Record Batches with the POR data file.  In this context, the Process of Record refers to 
a collection of data collected before a change, or a suspected change, has been made to 
the system.  If were evaluating new process tool software, the Process of Record 
Batches would be the data that was collected before the change was made.  

Step 1  Select Process of Record Data
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Tutorial 5:  Student T Tests

• Select the W100 Trace ID (not the W100 Precoat) in the Batch Selection listbox.
• Leave default values on all other controls.
• Then click on Ok.

Step 1  Selecting Process of Record Data (continued)
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Tutorial 5:  Student T Tests

• Click on the next button, Select Test Batches.
• Select the W101 Trace ID (not the W101 Precoat) in the Batch Selection listbox.
• Leave default values on all other controls.
• Then click on Ok.

Step 2  Selecting Test Data
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Tutorial 5:  Student T Tests

• Click on the next button, Select Confidence Level.
• Select the confidence level you would like to use for the test.  The higher the 

confidence level the greater confidence you can have in your test report conclusions.
• Recommendation:

Select 99.9%
• Click on OK.

Step 3  Select Confidence Level
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Tutorial 5:  Student T Tests

• Click on Select SPC Charts/View Dual SPC Charts.
• Select SPC Charts of interest from the listbox and click on View Chart to display a 

Dual SPC Chart.  For Dual SPC Charts, Test data is displayed in black while Process of 
Record data is displayed in blue.

• Make sure a check mark is placed next to the SPC Charts you would like to test from 
the list.

• Recommendation:
Select MFC A Readback Overshoot Area Step 1.
Select Deposition 1 Time.
Select Deposition 2 Time.

Step 4  Select SPC Charts
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Tutorial 5:  Student T Tests

• Then click on Perform Comparison.
• Test results will be displayed on screen.  
• For each selected parameter, if there is no statistical difference between the 2 data sets, 

a Pass result will be generated.
• If a statistical difference is detected or if there is not enough data points to perform the 

test, a Fail result will be generated.
• Use the File menu to print the test report or to save it as a text file.

Step 5  Perform Student T Test
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Tutorial 5:  Student T Tests

• Start deposition simulation by clicking on the Start button. Take a lunch and collect at 
least 5 sets of 16 deposition cycles (more is better, run it over night if you can).

• Perform a Student T test to determine if MFC A Readback Overshoot Area Step 1 
has a difference between trigger 1 and trigger 10.

Extra Credit


